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UT GeoMechanics Lab 

CRS Procedure (in accordance to ASTM D0422-63R07) 

 

1. Before you start. 
We want to minimize the amount of time cores spend outside of the refrigerator 
and exposed to air, so it helps to have everything you’ll need ready to go before 
you get the sample out.  

1.1. Prepare Load Frame 
 

[ ] Turn off load frame, pump(s), network module, external power supply, and 
computer. 

  [ ] Turn on power supply, load frame, pump(s), network module, and computer.  

  [ ] Start Sigma-1 CRS software. 

  [ ] Open Cell Pump Screen 

  [ ] Point pump valve to DI water carboy 

  [ ] Fill pump with water 

  [ ] Purge any air bubbles back into carboy 

  [ ] Point pump valve to the CRS system. 

 

1.2. Prepare the CRS chamber 
 

[ ] Select cutter ring (also called specimen ring), either 5.0 cm (1.96’) or 6.35 
cm (2.5”) diameter, depending on the width and condition of your sample and the 
desired maximum stress.   

[ ] Clean inside of CRS chamber and base if necessary 

[ ] Make sure that Platten in CRS chamber is same size as the chosen cutter ring  

[ ] Get two clean porous stones and one filter paper of the proper size for your 
cutter ring and place them in a beaker filled with DI water. Set the beaker in the 
ultrasonic bath to clean and fully saturate the stones and filter paper. 
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[ ] Grease the square-sided rubber O-ring generously with a grease sealant such 
as Dow Corning compound 111 valve lubricant & sealant. (there is usually a tube 
of this in the drawer with the trimming tools).  

[ ] Grease the outer edge of the circular structure on the CRS base that the cutter 
ring will rest on. 

[ ] Grease the inner surface of the cutter ring. Be careful not to use too much 
grease. You should barely be able to leave a mark with your fingernail on the 
greased inner surface. 

[ ] Weigh the greased cutter ring along with the moist (not dripping) piece of 
filter paper, and record the mass under “Mass of Ring + FP (g)” on the sample 
data form in the CRS binder. If there is no hardcopy available, you can find the 
sample data sheet on the server under this location:  

\shannon\All_Access\GeoMechanics_Lab\Tests\Test_Worksheets\ 

[ ] Also, save a digital copy of the worksheet in a new folder with the test 
number as its name, for example, 
\shannon\All_Access\GeoMechanics_Lab\Tests\CRS\UT\CRS105\CRS105.pdf if 
this is CRS test # 105. 
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1.3. Round up supplies for sample preparation  
(See illustrations on the next page to identify) 
In the GeoMechanics Lab we deal with two types of samples: 1) intact cores still 
contained in a core tube and 2) reconstituted samples that are not in a core tube, 
instead in the consolidometer (Resedimentation device). Preparation tools and 
preparation is slightly different for both. If you are using a sample that is not still 
in a core tube, you will only need the items in bold. 

  [ ] Deburring tool (1) 

  [ ] Wire and guide tube (2) 

  [ ] Acrylic discs and cut pieces of wax paper (3) 

  [ ] Wire saw (4) 

  [ ] Trimming tools (5)  

[ ] 50 mm cutting ring and acrylic recess tool (6) or 63.5 mm cutting ring and 
recess tool (7) Note, the new 50 mm recess tool is opaque white acrylic and has a 
larger recess than the one shown in the picture.  

  [ ] Straight razor blade (8) 

  [ ] Extruding jig (A) and disc (a’) 

  [ ] Trimming jig (B) 

  [ ] Trimming Block (C) 

You may also find that C-clamps, pliers, and wooden blocks come in handy 
during the extruding and trimming process. For instance, the wire can be locked 
to the table at one end with a C-clamp and wooden blocks, freeing up a hand for 
other work while it is in use. The extruding jig can also be clamped to the table 
with blocks to make it easier to handle and to lift it up higher above the working 
table.  
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1.4. Initial measurements, data sheet and miscellaneous. 
   

[ ] Fill out sample name, project, date, etc on CRS data sheet 

[ ] Measure the diameter and height of cutter ring at 4 positions using a caliper 
and calculate an average number for both values. Make sure that for the height 
measurement you only measure the height down to the recess tool. Note both 
numbers on data sheet under “Height of Specimen (cm)” and “Diameter of 
Specimen (cm)”. 

[ ] Label and weigh four tares for trimmings and record their label numbers and 
masses in data sheet under “Tare Number” and “Tare Mass”. 

[ ] Label a plastic Ziploc bag for trimmings with CRS test number and contents 
(type of sample).   

[ ] Gather a vacuum sealer and plug it in if you are taking your specimen from a 
longer piece of core and will need to return the remainder of the core to the 
freezer. 

 

2. Sample Preparation 

2.1. Extract sample from core  
As with section 1.3, if you are using a sample which does not need to be extruded 
from its tube, you will only need to do the items in bold below.   

[ ] Retrieve core sample from refrigerator or extrude from consolidometer 
(for details see procedure for Resedimentation). 

[ ] Open core packaging by cutting off the top, just below the seal, with scissors or 
razor blade. Save bag. 

[ ] Determine which end of the core is up. Usually some indicator like an arrow 
or label will be on the tube. Be sure to keep track of this throughout the 
preparation process!  

[ ] Using a large, black sharpie, write “up” arrows all along the length of the core 
tube so that any interval cut from the core will have an up indicator.  

[ ] If necessary, remove end caps and tape from sample tube so you can inspect 
core.  
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[ ] If you are doing a CRS test on an intact core specimen, choose an interval of 
core, 5 cm in length for vertical samples, 7.5 cm for horizontal samples. The ideal 
interval will be as homogeneous as possible and without cracks. 

[ ] Using band saw, cut the desired interval of core and tube.  

[ ] Recap core tube and seal with black electrical tape.  

[ ] Return core to its original bag (with label) 

[ ] Put core bag within Vacuum seal bag with a wet paper towel, vaccum and seal. 

[ ] Debur specimen tube (this means strip off splintered or jagged  bits from the 
cut edge and inside of the tube using the deburring tool. To do so, lay the core 
tube on the table with the cut surface facing you. Hold it with your left hand. 
Debur only a quarter from about 3 o’clock to 6 o’clock. Then rotate the sample by 
a quarter of a rotation clockwise and repeat until the entire cut surface is deburred. 
(It may not be necessary to do this if the tube is made of plastic, as ours usually 
are. It is crucial for metal tubes though.)   

[ ] Place the sample up right on the table (“up” arrow pointing to the ceiling) with 
only a small portion of the sample protruding over the edge of the tabletop. At 
that point, slowly and carefully push the steel guide tube downward through the 
sample between specimen and tube. Pull the thread wire through the steel guide 
tube till both ends of the wire are sticking out of both ends of the sample. Then 
remove the steel tube while you keep the thread wire in place. 

[ ] Use a C-clamp to fasten one end of the wire to the countertop. Pull the wire 
taut (with pliers, for example) and then rotate the tube in its own location around 
the long axis. This will loosen the sample from the tube.  

[ ] Place the sample and tube into the extruding jig, making sure that the bottom 
of the sample is sitting on the base of the extruding jig. Do not flip the sample 
which would result in applying pressure opposite to the direction in which it is 
applied in-situ. 

[ ] Put a round piece of wax paper and then the disc (a’) on the top end of the 
sample. 

[ ] Use the extruding jig and disc to push a few millimeters of sample out of the 
tube. 

[ ] Use the wire saw to cut off the bottom edge of the sample where the saw 
blade may have strained or disturbed it.  
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[ ] Now use the extruding jig and disc to gently push the rest of the sample out of 
the tube and on to an acrylic disc with wax paper above it.  

After the sample is out of the tube, be careful not to forget which end is the top 
and which end is the bottom. You may wish to mark the acrylic discs or round 
pieces of wax paper and keep them on or near the top or bottom as reminders.  

 

2.2. Trimming the Sample 
Your goal here is to have the cutter ring completely filled with the sample, without 
cracks or voids, and smooth top and bottom surfaces.  

[ ] If the top of the sample has been in contact with the band saw or otherwise 
strained, cut it off by laying the sample in the trimming block with the top few 
millimeters extended off the edge, and cutting down along the posts with the wire 
saw. 

[ ] Use an ungreased cutter ring of the same diameter as your greased cutter ring 
(if available), press down gently into the top of the sample to make a shallow 
circular impression which will be a guide to you in trimming the sample. 

[ ] Place the sample facing upward (with the circular impression visible) on the 
trimming block with one side overlapping the recessed edge. 

[ ] Cut a strip off the side by sliding the wire saw down the guide posts on the 
trimming block. Use the circular impression on the top as a guide and leave a 
couple of millimeters around it.  

[ ] Rotate the sample and repeat process until you have formed a solid with top 
and bottom surfaces that are at least octagonal, and with about 2-3 mm of excess 
material on the sides surrounding the circular impression on the top. 

[ ] Turn the sample upside down on a wax-paper-covered acrylic disc, and place 
in the trimming jig with the top facing down.  

[ ] Insert the cutter ring – tapered end facing downward -  in the top of the 
trimming jig, carefully lower the trimming jig with cutter ring till it reaches the 
sample and let it rest on the sample.  

[ ] Push the ring slowly down into the sample (~1 mm). 

[ ] Trim off the excess material around the edge of the ring that was produced by 
pushing the cutter ring into the sample. 
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[ ] While trimming rotate the specimen by turning the plastic spacer of trimming 
jig that holds cutter ring (do not turn cutter ring directly).  

[ ] Iterate the above three steps until the ring is filled, and a bit of trimmed core 
protrudes above the top. Be careful not to undercut the ring. If this happens, fill 
the gap with material you have previously scraped off. This is a delicate job. It 
can take up to an hour depending on the sample condition.  

[ ] Lift the plastic spacer so it detaches from the cutter ring and specimen. 
Remove the specimen and ring from the trimming jig. 

[ ] Using the wire saw or the straight blade knife, make a flat cut that removes any 
excess material beyond the cutting edge at the bottom of the cutter ring.  

[ ] Flip the sample over so that the top end faces up, setting it on a wax paper – 
covered acrylic disk. Use the straight razor blade, plane off the top surface of the 
specimen. Scraping gently with the blade inclined at about 45o is likely to be 
easier than cutting. Make sure the entire razor blade rests on the specimen ring as 
you pull it across the top surface towards you while holding the specimen ring in 
place. Don’t put too much pressure on it or the razor blade will bend, causing an 
uneven top surface.  

[ ] When you have a smooth surface, place the filter paper on top of it, making 
sure not to leave any air bubbles underneath. Then overturn the sample and cutter 
ring (cutting edge down) onto the recess tool and push it down so that excess 
material comes out of the bottom end of specimen ring. 

[ ] Now, using the straight razor blade and if necessary, the wire saw, remove 
excess material from the bottom side of the cutter ring and scrape the surface flat.  

 

3.  Setting up your test 
  

[ ] Take mass of specimen, sample ring, and filter paper, and write the measurement 
down on the data sheet under “Mass of Ring + FP + Spec. (initial) (g)”. 

[ ] Remove the top of the CRS chamber. 

[ ] Lock the piston in the upright position.  

[ ] Put a 2.5” DI water saturated porous stone in the base of the CRS chamber 

[ ] Make sure base water line is closed. 
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[ ] Wipe off any excess water.  

[ ] Add a little bit of grease along the bottom edge of the cutter ring; at the contact points 
with the CRS base. 

[ ] Put the specimen into the CRS chamber, with the ring overlaying the raised circular 
area in the base which contains the porous stone, and with the cutting edge of the ring 
facing up. 

[ ] Place a porous stone of the appropriate size and saturated with DI water on top of the 
specimen and filter paper, partially recessed inside the cutting edge of the ring.  

[ ] Slowly put on the top of the CRS chamber. 

[ ] Lock down the top of the CRS chamber. Screw the three bolts in and make them more 
than hand-tight but don’t overtighten them. Use a torque wrench and apply 60 inch-
pounds of torque to each nut.  

[ ] Make sure the Base Valve is open on the chamber. [ ] Make sure the top drain valve 
is open on the chamber.  

[ ] Unlock the piston and slowly lower it until the platen (the foot at the base of the 
piston) is resting atop the porous stone.  

[ ] Make sure that the pump is full of water and that the pump valve is pointed in the 
direction of the CRS chamber. 

[ ] Open the Cell Pump window in your Sigma-1 CRS software, if it is not already open. 

[ ] Select the Volume Control tab, if it is not already selected in the main right-side area 
of the cell pump screen.  

If you are using saline chamber fluid, modify the following three steps by adding saline 
brine to the reservoir attached to the load frame, instead of using the pump to fill the 
chamber.  

[ ] Set the pump to 10 ml/minute, 50 ml volume, and click the up arrow button (the 
second one, not the one that looks like this  but the one that looks like this ).  

[ ] Now fill the chamber the rest of the way, still at 10 ml/min. Water will flow out the 
top drain valve when it’s full (So the end of the drain tube should be in a bucket or 
something). 

It is likely to be necessary to re-fill the pump at some point. Do this by stopping the pump, 
turning the valve towards the DI water carboy, and clicking the maximum rate down 
arrow  in the volume control area of the screen. Then, turn the pump valve back 
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towards the CRS system, reselect the controlled-rate up button, , and return to filling 
the chamber at 10 ml/min. 

[ ] Once water is flowing out the top drain line, the chamber is full. Stop the pump and 
close the top drain valve. If you can see large air bubbles trapped within the chamber, 
you may wish to try to drive them out by gently tilting the chamber (while holding it 
securely) to let them escape up the piston and into the top drain valve. This should be 
done after stopping the pump, but before closing the top drain valve.  

[ ] Take the CRS chamber, and put it on the load frame platform, with the piston 
underneath the load cell. It may be necessary to lower the load frame in order to do this. 
Go to the “tools” menu in the Sigma-1 CRS window and select manual mode. Then use 
the or buttons to lower the platform. 

[ ] The shear break, a short metal cylinder with a flat surface on the top and a concave 
surface on the bottom end, should now be placed over the top convex end of the piston, 
which it is machined to fit. Then slide the CRS chamber until the shear brake is 
underneath the corresponding metal cylinder at the bottom of the load cell. 

Exception: the 50,000 lb load cell in its current configuration does not require a shear 
brake. The bottom surface of the load cell is concave and the chamber should be aligned 
so that the convex tip of the piston fits into this recess. 

[ ] Make sure that the piston is locked.  

[ ] Using the button in the manual mode box, and a very slow rate of displacement 
(such as 0.05 in/minute to close the last little gap of space), carefully move the load frame 
up until the shear brake top is just touching the bottom cylinder on the load cell. Be very 
careful not to let the load cell put significant force on the piston, you are just raising the 
chamber so that you can make a final alignment. 

[ ] Make sure that the piston and shear brake are exactly lined up with the load cell.  

[ ] Zero your DCDT sensor and your pressure transducers. Select the “setup” menu, then 
“sensors”. In the sensors window, click on each sensor in turn and then “test” and “take 
zero”. 

[ ] Lower the load frame a few mm, then zero the load cell using the same procedure as 
you did for the other sensors.  
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3.1. Test configurations 
 

[ ] Go to the File menu and select 
Specimen Data.  

Fill out the form which pops up with 
enough information to identify the 
specimen. Use the test number such as 
CRS0105 as Specimen Number. 

Make sure that the specimen diameter is 
correct. For the smaller rings it should 
be about 1.96, for the larger rings, 2.49. 

 

 

[ ] Return to the File Menu and select Test Data. Fill out the form which pops up. 
Recommended Settings follow: 
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[ ] in the test data window, select a loading schedule appropriate for your test specimen, 
testing plan, and apparatus configuration. If an appropriate loading schedule is not 
already set up, you will need to create one yourself (Appendix to be written).  

4. Starting your test  
  

[ ] Raise the platform slowly and carefully until the shear break (or top of the piston if 
you are using the 50k setup) is almost touching the bottom of the load cell.  

[ ] Click the Make Contact button. This will slowly raise the platform and make contact 
between the shear break and the load cell. When contact is made, click the OK button in 
the dialog window. Note: The Dialog window says to unlock the piston here before 
clicking OK, but our procedure as it currently stands is to wait until after the 
backpressure phase starts to unlock the piston. So don’t unlock the piston. After you’ve 
clicked OK in the dialog box, the Make Contact button will change into a Start Test 
button. Click it.  

[ ] Start a manual datafile for the backpressure saturation phase of the test. In the Tools 
menu, click Data Acquisition, then New Task. Type in a filename for it to save as. 
Then, select your reading schedule from the drop-down menu. (The recommended 
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reading schedule is one reading every 4 minutes. If there isn’t an available 4 minute 
schedule, or you’d like to set up a custom schedule, then go to the File menu, then click 
on Reading Schedules, and Add Schedule, and set one up using the dialog box). 

 [ ] Go to your Cell Pump window. Select the Pressure Control tab. Set it to Ramp 
Pressure to 56 PSI over 180 Minutes.  

[ ] Once the system reaches a couple of PSI, unlock the piston. (1/4 turn 
counterclockwise). 

[ ] Now, you’re pretty much done with this for today. Leave the chamber to pressure up, 
which will take three hours. Then, leave it to sit at backpressure overnight, or for at 
least 8 hours. In this time, the high pressure should drive any remaining air bubbles into 
solution and fully saturate your sample.  

    ………………………………… 

[ ] After leaving it at backpressure overnight, click Pause (at the bottom of the screen), 
then Done (lower right hand corner), then Yes (in the dialog box, when it asks if you 
want to start the consolidation portion of the test). 

[ ] Start a new manual data acquisition file for the consolidation test. In the Tools menu, 
click Data Acquisition, then End Task to close your backpressure datafile. Then go 
back to the Tools menu and the Data Acquisition option, and select New Task. Type in 
a filename for it to save as. Then, select your reading schedule from the drop-down menu. 
(The recommended reading schedule is one reading every 4 minutes. If there isn’t an 
available 4 minute schedule, or you’d like to set up a custom schedule, then go to the File 
menu, then click on Reading Schedules, and Add Schedule, and set one up using the 
dialog box). 

[ ] The program will move to the Consolidation tab. Check your loading schedule, which 
appears in the right-hand side of the screen. If you need to make any changes, right-click 
on the part you want to change and then select Edit from the menu, which appears.  

 [ ] Click Start (bottom middle of screen), and let your test run.  

[ ] add: frequent checking on test and ensuring PPR is in desired range (please explain 
and specify… like ASTM suggests 5-12, however, in our lab we use 2-5) note: not sure 
on exact numbers – you will have to look these up. 

5. Ending your test 
 

[ ] Go to the Tools menu, and click on Data Acquisition and Close Task to end your 
manual data acquisition.  Click Yes in the Dialog that appears asking for confirmation. 
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 [ ] Lock the Piston.  

 [ ] Hit the Pause button, then Done (bottom right).  

 [ ] Program will exit. Relaunch the program. 

 [ ] Open bottom valve on chamber. 

[ ] Take the pressure off the chamber by going to Cell Pump window, Pressure Control 
tab, and selecting Ramp Pressure  to 0 PSI over 10 minutes. 

[ ] Mark and weigh a tare for final specimen measurement, and record the measurement 
in the CRS data sheet.  

 [ ] Stop pump when pressure = 0 PSI. 

 [ ] Turn off pump valve (point straight up). 

[ ] Lower load frame (in manual mode, accessible from the tools menu) until there is a 
visible gap between the shear brake and the load cell. 

 [ ] Remove the chamber from the load frame.  

 [ ] Close the bottom valve. 

 [ ] Open the top drain valve. 

 [ ] Remove the top of the chamber (carefully). 

 [ ] Weigh the sample in the cutter ring, along with the porous stone and filter paper.  

[ ] Extrude the sample onto your recently labled-and-weighed  tare by pressing against 
the porous stone on the top of the specimen. Then, remove the porous stone and filter 
paper from the top of the specimen. 

[ ] Weigh the tin and sample, and record the measurement in the CRS data sheet in the 
logbook. 

[ ] Put the tare with the specimen in the oven (80o C) and dry for at least 24 hours before 
weighing it again.  
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Appendix 1: Processing your data. 

[ ] Copy and paste the raw datafile into the spreadsheet found at 
\All_Access\Geomechanics_Lab\Tests\Data_Templates\CRS_Template_March2012.xlsx 

[ ] Look at your backpressure datafile. The base pressure and cell pressure sensors should have 
equal readings throughout the backpressure phase, since they valve is open and pressure 
communicates between them. If there is a difference between the readings at 56 PSI, adjust the 
zero value for the cell pressure transducer until its pressure output is identical to the pore 
pressure transducer. This will improve the accuracy and precision of your permeability 
measurements, particularly in the early stages of the consolidation test.  

 


